
1

VedaType
User’s Manual

Version 2.0
23 August 2008



2

VedaType 2.0 User’s Manual

Introduction ............................................................................................. 2
Installation ............................................................................................... 3
Fonts ..................................................................................................... 3
Getting Started ......................................................................................... 4

Selecting MacRoman ................................................................. 4
Turning Off Auto Typing Features............................................. 4
Turning Off Spell Checking ...................................................... 5
The Devanagari Font ................................................................. 5
Typing Devanagari Characters .................................................. 6
An Example of Typing Devanagari ........................................... 6
Typing Transliteration Characters ............................................. 8

Font Utilities ............................................................................................. 9
Key Caps and Keyboard Viewer ................................................ 9
Font Charts ................................................................................. 9

PDF Files ............................................................................................... 10
Using VedaPad Fonts with TeX ............................................................ 11
Font Charts ............................................................................................ 12

Vedic97 Font in Devanagari Alphabetical Order .................... 12
Transliteration Characters in VedicTrans97 Font ................... 17
Devanagari Characters in VedicTrans97 Font ......................... 18
Vedic97 and VedicTrans97 Fonts in Numeric Order............... 19

Support ................................................................................................... 29
Credits  ................................................................................................... 29



3

Introduction

VedaType is a system for typing Devanagari, the alphabet of Sanskrit, on Macintosh

computers. A companion product, VedaPad, runs on Windows computers. This manual
describes VedaType version 2.0.

VedaType is designed for Sanskrit, including Vedic Sanskrit.  It is not designed for
Hindi, Marathi, or other modern Indian languages that use Devanagari, since these
languages require special letters and ligatures that are not included in VedaType.

VedaType includes fonts and this manual.  It does not include the word processing
software that is part of VedaPad.  The software in VedaPad enables you to produce
Devanagari by typing in a transliteration on your keyboard. For example, suppose you

wish to type /mR=e]e kÚ̈ =e]e.
• In VedaPad, you start the VedaPad software and type dharmakSetre kurukSetre.

The Devanagari appears on the screen. You can then save the Devanagari to a file or
copy it to another program.

• In VedaType, you start any program and select the Devanagari font. Then you type
/mR=e]e k(opt-shift-1)(opt-r)=e]e.

The second procedure is thoroughly described in this manual. If you have a choice, you
may prefer to use VedaPad over VedaType.
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Installation

To install VedaType, you must download the product zip file, and then install the font
files.  Save the zip file to your computer.  The file should appear on the desktop, and its
contents should appear as a folder on the desktop.  If the folder does not appear
automatically, then you must unzip the file yourself into a folder.  Inside the folder you
should find several font files, with extension .ttf, and this manual as a PDF file. Drag the
font files into the Fonts folder under the System Folder folder.

Fonts

VedaPad includes two fonts:

• Vedic97: Devanagari font
• VedicTrans97: Transliteration font

Both these fonts are available in all applications. These fonts are not Unicode compliant.
They have their own proprietary encoding which is unique to VedaType. Therefore, you
cannot covert text that is set in other fonts directly into VedaType fonts.

You can copy Devanagari and transliteration text as you would any other text. Other
users can see the Devanagari and transliteration text set with VedaType, as long as the
computer they are working on has the VedaType fonts installed.

Obsolete versions of VedaPad and VedaType contained Devanagari and transliteration
fonts with other names.  If someone sends you an RTF, Doc, or similar file that was
produced with an old version of VedaPad or VedaType, and you are unable to read the
document, check the font name in the affected section to see if it matches the above
names.  If not, you may be able to read the document by changing the font in your copy.
If you still cannot read it, the person who sent you the file must correct it, either by
changing the font and the text, or by converting the file to a PDF file.  See PDF Files
below.
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Getting Started

Selecting MacRoman

To use the method of entering text that is described below, your Mac must be set to use
the Standard Roman character set, also called MacRoman.  Most computers are already
set up for this.  Exceptions include users who have set up their Mac to be used in a
language other than English.  Use the steps below if you believe your Mac may not
already be set to MacRoman.

In System 9 and earlier:

• Go to the Text or Keyboard control panel
• Set the script to Roman.

In OS X 10.2 and earlier:

• From the Apple menu, start System Preferences.
• From the View menu, select the International pane.
• Click on the Language tab.
• Set the script to Roman.

In OS X 10.3 and later:

• From the Apple menu, start System Preferences.
• From the View menu, select the International pane.
• Click on the Language tab.
• Click on the Customize Sorting button.
• Set the script to Roman.

Turning Off Auto Typing Features

In every application in which you plan to use VedaType, you must turn off all the
features which automatically change certain characters you type into other characters.
For example, Word is normally set to change straight quotation marks, ", into curly
quotation marks, “ or ”.  These character substitutions work fine with standard English
fonts, but they produce incorrect Devanagari characters with VedaType fonts.
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The steps you need to follow to turn off this feature vary with each application.  Below
are directions for turning them off in Word X for Mac.  In other programs, you usually
follow a similar procedure.

• From the Tools menu, select AutoCorrect.
• Click the AutoCorrect tab.
• Uncheck all items.
• Click the AutoFormat As You Type tab.
• Uncheck all items in the Replace as you type section.
• Click the AutoType tab.
• Uncheck all items.
• Click the AutoFormat tab.
• Uncheck all items in the Replace section.
• Click OK.

Turning Off Spell Checking

Some applications have automatic spell checking enabled by default.  This is fine for
English, but it labels every Devanagari word as misspelled.  If your document contains a
large amount of Devanagari, you may wish to turn off this feature.  The steps you need to
follow vary with each application.  Below are directions for turning them off in Word X
for Mac.  In other programs, you usually follow a similar procedure.

• From the Word menu, select Preferences.
• Click Spelling and Grammar.
• Uncheck the following items: Check spelling as you type, Always suggest

corrections, Check grammar as you type, and Check grammar with spelling.
• Click OK.

The Devanagari Font

In VedaType, you type Devanagari as a series of complete letters, each representing a
complete syllable.  A complete letter consists of one or more letter elements, each of
which is a character in the font.  A table of the main font containing Devanagari
characters, the Vedic97 font, is in the Font Tables section below.  This table tells you
how to type each letter element in the font.  The Vedic97 font contains the following
types of letter elements:

• Full letters such as a or m, including full conjunct characters such as õ or =.

• Half letters such as M, including half conjunct characters such as +.
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• Simple matras, including vowel matras such as   u or   e, pre- and post-letter r-matras,
anusvaras, viramas, and Vedic accents.

• Left matras such as i .

• Right matras such as  I  and o .

• Miscellaneous characters such as punctuation and digits.

Most of the matras have several different versions, which differ mainly in their horizontal
position, so that the matra can be placed at various points relative to the full letter.

Typing Devanagari Characters

To type Devanagari, use the following procedure.

• Open the application in which you wish to type Devanagari.
• Select the Vedic97 font.
• Identify the complete letters in the Devanagari text you wish to type.
• Identify the letter elements in each complete letter.
• Locate these letter elements in the Vedic97 font table.
• Type each letter element using the keystrokes in the font table.

To type a conjunct consonant, use these steps.

• See if there is already a full conjunct character.  If you are setting a triple or more
conjunct, look for a conjunct character for some of the consonants.

• If there is no conjunct character, look for a half letter for the first letter element.
• If there is no conjunct character or half letter, use a full letter plus virama instead of a

half letter.

To type a complete letter, you must type each of the letter elements in this order:

• Left matra, if any
• Half letters, if any
• Full letter
• Right matra, if any
• Simple matras, if any

An Example of Typing Devanagari

We will illustrate the above process by identifying the keystrokes you would use to type
the first verse of the Bhagavad-Gita.  Here is the Devanagari for this verse:
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/mR=e]e kÚ̈ =e]e smvet; yuyuTsv" )
m;mk;" p;<@v;’wv ikmkÚvRt s'jy Ð1Ð

The first word, /mR=e]e, contains four complete letters, /, mR, =e, and ]ee.  We type this
word as follows.

• The first complete letter, /, consists of one letter element.  The font table lists the

keystroke for this character as /.  We type this letter by pressing / on the keyboard.

• The second complete letter, mR, consists of two letter elements, m and   R.  The second

letter element,  R, is a simple matra and therefore must be typed after the full letter,
even though by sound it comes first.  The font table lists the keystrokes for these
characters as m and R.  We type this letter by pressing m and R on the keyboard.

• The third complete letter, =e, consists of a full conjunct character = and a matra  e.
The keystrokes for these letter elements are = and e.

• The fourth complete letter, ]ee, consists of a full conjunct character ] and a matra   ee.
The keystrokes for these letter elements are ] and e.

To summarize, we type the first word, /mR=e]e, by typing the keystrokes /mR=e]e.
Here are some points of note as we type the rest of the verse.

• For the first complete letter of the second word, kÚ, if we type ku, we will get the

poorly aligned letter ku . We can improve the alignment by using one of the other u-

matra characters.  In this case, we can use the u-matra with keystroke option-shift-1,

which yields kÚ.
• The second complete letter of the second word, ¨, is a full conjunct character that is

typed with option-r, without any need for a separate u-matra character.

• In the fourth word, the conjunct Ts is typed as the half letter T and then the full letter

s.

• In the second word of the second line, the conjunct character ’ is typed with two

keystrokes, option-e and then i.  Several other characters in the font are typed with
two keystrokes.

• In the third word of the second line, the complete letter ik is typed as ik, even though
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it is the reverse order by sound.

Here are the keystrokes for typing the whole verse.

/mR=e]e kÚ̈ =e]e smvet; yuyuTsv" )
/mR=e]e k(opt-shift-1)(opt-r)=e]e smvet; yuyuTsv" )

m;mk;" p;<@v;’wv ikmkÚvRt s'jy Ð1Ð
m;mk;" p;<@v;(opt-e)iwv
ikmk(opt-shift-1)vRt s'jy (opt-hyphen)1(opt-hyphen)

Typing Transliteration Characters

Transliteration consists of letters with and without diacritical marks.  A letter without a
diacritical mark is an ordinary letter that you type as in English.  To type a letter with a
diacritical mark, you do not type the diacritical mark separately, but instead type one or
two keystrokes to get the combination of a letter and a diacritical mark.  For example,
you type option-a to get Œ.

The VedicTrans97 font contains a complete set of letters with and without diacritical
marks.  A table of this font in the Font Tables section lists the keystrokes you type to get
the letters with diacritical marks.

To type transliteration, use the following procedure.

• Open the application in which you wish to type the transliteration.
• Select the VedicTrans97 font.
• Type letters that do not have diacritical marks as in English.
• Type letters that have diacritical marks using the keystrokes in the font table.

Here is a transliteration of the first verse of the Bhagavad-Gita along with the
keystrokes that are used to type it.

dharmak·etre kuruk·etre samavetŒ yuyutsavaú
dharmak(opt-w)etre kuruk(opt-w)etre samavet(opt-a) yuyutsava(opt-h)
mŒmakŒú pŒö¶avŒ§caiva kimakurvata saµjaya (1)
m(opt-a)mak(opt-a)(opt-h) p(opt-a)(opt-j)(opt-d)av(opt-a)(ops-s)caiva
kimakurvata sa(opt-m)jaya (1)
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Font Utilities

Key Caps and Keyboard Viewer

Key Caps and Keyboard Viewer are programs that show an image of the keyboard and
allow you to select a font.  Each key in the keyboard image shows the corresponding
character from the selected font.  When you press combination keys such as Shift, Cmd,
or Option, the characters on the keys change to show you what results with that
combination. You can insert characters from the font in your document by first setting the
font, and then either clicking the screen images of the keys or pressing the physical keys.

On System 9 and earlier, and OS X 10.2 and earlier, use Key Caps. In System 9 and
earlier, Key Caps is a desk accessory on the Apple menu. In OS X 10.2 and earlier:

• Open a Finder window.
• Open the Applications folder.
• Open the Utilities folder
• Click on Key Caps.

On OS X 10.3 and later, use Keyboard Viewer.  You access this program from a menu
which is normally hidden.  To activate this menu:

• From the Apple menu, start System Preferences.
• From the View menu, select the International pane.
• Click on the Input Menu tab.
• Click the Show Input Menu in Menu Bar and Show Keyboard Viewer options.
• A flag icon will then appear in the menu bar.  The type of flag depends on the default

language.

To use Keyboard Viewer, click on flag icon and select Keyboard Viewer from the
menu.

Font Charts

There are many programs that you can download, some of them for free, that show a
whole font as a chart of characters and allow you to insert a character from a font by
clicking on it.  You may prefer this approach to looking up keystrokes.  Two such free
programs are:

• For System 9 and earlier, Font Checker, which you can download from
http://mac.softpedia.com/get/Font-Tools/Font-Checker.shtml.

• For OS X, Font Sampler, which you can download from
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http://mac.softpedia.com/get/Utilities/Font-Sampler.shtml.

PDF Files

PDF files are the Portable Document Format developed by Adobe. This file format has
become a widespread standard on the web, since it can contain any kind of font or
graphics without the user having to install special font or graphics software. The PDF
format is usually best for sharing files containing VedaType text with people who do not
have VedaType. PDF files can be viewed with Adobe Acrobat Reader, a free product that
can be downloaded at http://www.adobe.com/products/acrobat/readstep2.html.

In OS X, you can convert almost any kind of file into a PDF file:

• Open the file in a native OS X application.
• On the File menu, select Print.
• Click Save As PDF.
• The application will display the original file converted to a PDF in a PDF viewer.
• Within the PDF viewer, save the PDF file, if desired.

In System 9 and earlier, you must install additional software to create a PDF.  We suggest
PrintToPDF, a shareware product that you can download from
http://www.jwwalker.com/pages/pdf.html and that costs $20 to register.
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Using VedaPad Fonts with TeX

VedaPad includes VedaTeX, a system to support VedaPad fonts within the typesetting
system TeX.  VedaTeX is located in the vedatex folder within the VedaPad folder.
Detailed instructions are in the VedaTeX manual, vedatexmanual.pdf, in the
vedatex\doc\generic\vedatex folder.
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Font Charts

Vedic97 Font in Devanagari Alphabetical Order

Vedic
97  Keystrokes Code

A  a 97

;  ; 59

”  Option-i i 148

á  Option-Shift-9 225

i  i 105

É  Option-; 201

²  Option-, 178

â  Option-Shift-0 226

¾  Option-' 190

®  Option-Shift-' 174

é  Option-` Shift-e 233

I  Shift-i 73

Ç  Option-\ 199

¡  Option-Shift-8 161

¬  Option-u 172

u  u 117

Ÿ  Option-u u 159

‘  Option-u e 145

Ú  Option-Shift-1 218

è  Option-u Shift-e 232

U  Shift-u 85

†  Option-u Shift-u 134

Ë  Option-` Shift-a 203

A  Shift-a 65

O  Shift-o 79

È  Option-Shift-\ 200

•  Option-Shift-a 129

¿  Option-o 191

ò  Option-Shift-; 242

E  Shift-e 69

e  e 101

¼  Option-0 188

¹  Option-p 185

ƒ  Option-e Shift-e 131

w  w 119

Ù  Option-u Shift-y 217

ø  Option-Shift-, 248

“  Option-` i 147

o  o 111

*  Shift-8 42
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'  ' 39

Ö  Option-/ 214

ù  Option-Shift-. 249

\  \ 92

"  Shift-' 34

‹  Option-n a 139

k  k 107

K  Shift-k 75

Õ  Option-Shift-] 213

Ô  Option-] 212

£  Option-3 163

=  = 61

+  Shift-= 43

%  Shift-5 37

:  Shift-; 58

g  g 103

G  Shift-g 71

¦  Option-7 166

`  ` 96

~  Shift-` 126

ß  Option-Shift-6 223

›  Option-n o 155

û  Option-k 251

•  Option-u i 149

Û  Option-Shift-2 219

Í  Option-n Shift-o 205

Ä  Option-f 196

©  Option-g 169

¤  Option-6 164

ì  Option-Shift-f 236

„  Option-n Shift-n 132

c  c 99

C  Shift-c 67

°  Option-5 176

z  z 122

½  Option-z 189

j  j 106

J  Shift-j 74

Æ  Option-j 198

D  Shift-d 68

Z  Shift-z 90

–  Option-n n 150

H  Shift-h 72

•  Option-c 141

ï  Option-Shift-j 239

$  Shift-4 36

¯  Option-Shift-o 175

š  Option-u o 154

#  Shift-3 35

@  Shift-2 64
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Ó  Option-Shift-[ 211

—  Option-e o 151

!  Shift-1 33

,  , 44

<  Shift-, 60

t  t 116

T  Shift-t 84

]  ] 93

}  Shift-] 125

ÿ  Option-t 160

æ  Option-i Shift-e 230

ˆ  Option-` a 136

q  q 113

Q  Shift-q 81

d  d 100

ë  Option-Shift-d 235

¸  Option-Shift-p 184

í  Option-` Shift-i 237

«  Option-e 171

¶  Option-d 182

õ  Option-Shift-b 245

º  Option-b 186

µ  Option-m 181

´  Option-y 180

Î  Option-Shift-q 206

{  Shift-[ 123

&  Shift-7 38

Š  Option-u a 138

Ã  Option-v 195

/  / 47

?  Shift-/ 63

Ý  Option-Shift-4 221

Þ  Option-Shift-5 222

n  n 110

N  Shift-n 78

¥  Option-8 165

p  p 112

P  Shift-p 80

¢  Option-4 162

Ò  Option-[ 210

f  f 102

F  Shift-f 70

b  b 98

B  Shift-b 66

.  . 46

>  Shift-. 62

m  m 109

M  Shift-m 77

»  Option-9 187

y  y 121
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Y  Shift-y 89

ä  Option-Shift-r 228

r  r 114

¨  Option-r 168

å  Option-Shift-m 229

[  [ 91

‰  Option-i a 137

^  Shift-6 94

R  Shift-r 82

³  Option-. 179

œ  Option-e u 156

Ü  Option-Shift-3 220

|  Shift-\ 124

l  l 108

L  Shift-l 76

v  v 118

V  Shift-v 86

x  x 120

X  Shift-x 88

ê  Option-Shift-s 234

’  Option-e i 146

Å  Option-x 197

•  Option-i e 144

s  s 115

S  Shift-s 83

˜  Option-` o 152

§  Option-s 167

W  Shift-w 87

ã  Option-Shift-w 227

·  Option-w 183

‚  Option-Shift-c 130

Ï  Option-q 207

h  h 104

ó  Option-i Shift-u 243

ô  Option-` Shift-u 244

ú  Option-h 250

ð  Option-Shift-k 240

ö  Option-Shift-i 246

÷  Option-Shift-n 247

ç  Option-Shift-y 231

î  Option-Shift-h 238

ñ  Option-Shift-l 241

×  Option-Shift-v 215

Ñ  Option-Shift-hyphen 209

Â  Option-l 194

À  Option-Shift-? 192

Œ  Option-a 140

)  Shift-0 41

Ð  Opt-hyphen 208

(  Shift-9 40
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­  Option-= 173

±  Option-Shift-= 177

ª  Option-2 170

Ø  Option-u y 216

‡  Option-e a 135

Ì  Option-n Shift-a 204

Á  Option-1 193

•  Option-` u 157

…  Option-u Shift-o 133

™  Option-i o 153

-  - 45

à  Option-Shift-7 224

0  0 48

1  1 49

2  2 50

3  3 51

4  4 52

5  5 53

6  6 54

7  7 55

8  8 56

9  9 57
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Transliteration Characters in VedicTrans97 Font

VedicVedic
TransTrans

9797
 Keystrokes Code

Ì  Option-n Shift-a 204

Œ  Option-a 140

…  Option-u Shift-o 133

ë  Option-Shift-d 235

¶  Option-d 182

î  Option-Shift-h 238

ú  Option-h 250

°  Option-5 176

Þ  Option-Shift-5 222

Ú  Option-Shift-1 218

Á  Option-1 193

ä  Option-Shift-r 228

Â  Option-l 194

¹  Option-p 185

ù  Option-Shift-. 249

µ  Option-m 181

õ  Option-Shift-b 245

º  Option-b 186

›  Option-n o 155

‹  Option-n a 139

ï  Option-Shift-j 239

Æ  Option-j 198

å  Option-Shift-m 229

¨  Option-r 168

í  Option-` Shift-i 237

©  Option-g 169

ê  Option-Shift-s 234

§  Option-s 167

ó  Option-i Shift-u 243

·  Option-w 183

æ  Option-i Shift-e 230

ÿ  Option-t 160

Û  Option-Shift-2 219

ª  Option-2 170

†  Option-u Shift-u 134

®  Option-Shift-' 174

Ë  Option-` Shift-a 203
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Devanagari Characters in VedicTrans97 Font

VedicVedic
TransTrans

9797
 Keystrokes Code

»  Option-9 187

±  Option-Shift-= 177

¥  Option-8 165

|  Shift-\ 124

¤  Option-6 164

•  Option-Shift-a 129

Ï  Option-q 207

É  Option-; 201

„  Option-n Shift-n 132

Î  Option-Shift-q 206

\  \ 92

Í  Option-n Shift-o 205

À  Option-Shift-? 192

Ä  Option-f 196

¯  Option-Shift-o 175

¸  Option-Shift-p 184

Ü  Option-Shift-z 252

‚  Option-Shift-c 130

£  Option-3 163

Ö  Option-/ 214

à  Option-Shift-7 224
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 Vedic97 and VedicTrans97 Fonts in Numeric Order

Code Standard
VedicVedic

Trans 97Trans 97 Vedic 97  Keystrokes

32 (space) (space) (space)  Spacebar

33 ! ! !  Shift-1

34 " " "  Shift-'

35 # # #  Shift-3

36 $ $ $  Shift-4

37 % % %  Shift-5

38 & & &  Shift-7

39 ' ' '  '

40 ( ( (  Shift-9

41 ) ) )  Shift-0

42 * * *  Shift-8

43 + + +  Shift-=

44 , , ,  ,

45 - - -  -

46 . . .  .

47 / / /  /

48 0 0 0  0

49 1 1 1  1

50 2 2 2  2

51 3 3 3  3

52 4 4 4  4
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53 5 5 5  5

54 6 6 6  6

55 7 7 7  7

56 8 8 8  8

57 9 9 9  9

58 : : :  Shift-;

59 ; ; ;  ;

60 < < <  Shift-,

61 = = =  =

62 > > >  Shift-.

63 ? ? ?  Shift-/

64 @ @ @  Shift-2

65 A A A  Shift-a

66 B B B  Shift-b

67 C C C  Shift-c

68 D D D  Shift-d

69 E E E  Shift-e

70 F F F  Shift-f

71 G G G  Shift-g

72 H H H  Shift-h

73 I I I  Shift-i

74 J J J  Shift-j

75 K K K  Shift-k

76 L L L  Shift-l

77 M M M  Shift-m
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78 N N N  Shift-n

79 O O O  Shift-o

80 P P P  Shift-p

81 Q Q Q  Shift-q

82 R R R  Shift-r

83 S S S  Shift-s

84 T T T  Shift-t

85 U U U  Shift-u

86 V V V  Shift-v

87 W W W  Shift-w

88 X X X  Shift-x

89 Y Y Y  Shift-y

90 Z Z Z  Shift-z

91 [ [ [  [

92 \ \ \  \

93 ] ] ]  ]

94 ^ ^ ^  Shift-6

95 _ _ _  Shift-hyphen

96 ` ` `  `

97 a a a  a

98 b b b  b

99 c c c  c

100 d d d  d

101 e e e  e

102 f f f  f
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103 g g g  g

104 h h h  h

105 i i i  i

106 j j j  j

107 k k k  k

108 l l l  l

109 m m m  m

110 n n n  n

111 o o o  o

112 p p p  p

113 q q q  q

114 r r r  r

115 s s s  s

116 t t t  t

117 u u u  u

118 v v v  v

119 w w w  w

120 x x x  x

121 y y y  y

122 z z z  z

123 { { {  Shift-[

124 | | |  Shift-\

125 } } }  Shift-]

126 ~ ~ ~  Shift-`

127 (del) • •  Delete
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128 Ä € €  Option-u Shift-a

129 Å • •  Option-Shift-a

130 Ç ‚ ‚  Option-Shift-c

131 É � ƒ  Option-e Shift-e

132 Ñ „ „  Option-n Shift-n

133 Ö … …  Option-u Shift-o

134 Ü † †  Option-u Shift-u

135 Á ‡ ‡  Option-e a

136 À ˆ ˆ  Option-` a

137 Â ‰ ‰  Option-i a

138 Ä Š Š  Option-u a

139 Ã ‹ ‹  Option-n a

140 Å Œ Œ  Option-a

141 Ç • •  Option-c

142 É Ž  Option-e e

143 È • •  Option-` e

144 Ê • •  Option-i e

145 Ë ‘ ‘  Option-u e

146 Í ’ ’  Option-e i

147 Ì “ “  Option-` i

148 Î ” ”  Option-i i

149 Ï • •  Option-u i

150 Ñ – –  Option-n n

151 Ó — —  Option-e o

152 Ò ˜ ˜  Option-` o
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153 Ô ™ ™  Option-i o

154 Ö š š  Option-u o

155 Õ › ›  Option-n o

156 Ú œ œ  Option-e u

157 Ù • •  Option-` u

158 Û ž  Option-i u

159 Ü Ÿ Ÿ  Option-u u

160 † ÿ ÿ  Option-t

161 ° ¡ ¡  Option-Shift-8

162 ¢ ¢ ¢  Option-4

163 £ £ £  Option-3

164 § ¤ ¤  Option-6

165 • ¥ ¥  Option-8

166 ¶ ¦ ¦  Option-7

167 ß § §  Option-s

168 ® ¨ ¨  Option-r

169 © © ©  Option-g

170 ™ ª ª  Option-2

171 ´ « «  Option-e

172 ¨ ¬ ¬  Option-u

173 ≠ ­ ­  Option-=

174 Æ ® ®  Option-Shift-'

175 Ø ¯ ¯  Option-Shift-o

176 ∞ ° °  Option-5

177 ± ± ±  Option-Shift-=
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178 ≤ ² ²  Option-,

179 ≥ ³ ³  Option-.

180 ¥ ´ ´  Option-y

181 µ µ µ  Option-m

182 ∂ ¶ ¶  Option-d

183 ∑ · ·  Option-w

184 ∏ ¸ ¸  Option-Shift-p

185 π ¹ ¹  Option-p

186 � º º  Option-b

187 ª » »  Option-9

188 º ¼ ¼  Option-0

189 Ω ½ ½  Option-z

190 Æ ¾ ¾  Option-'

191 Ø ¿ ¿  Option-o

192 ¿ À À  Option-Shift-?

193 ¡ Á Á  Option-1

194 ¬ Â Â  Option-l

195 √ Ã Ã  Option-v

196 ƒ Ä Ä  Option-f

197 ≈ Å Å  Option-x

198 ∆ Æ Æ  Option-j

199 « Ç Ç  Option-\

200 » È È  Option-Shift-\

201 … É É  Option-;

202 (nbsp) Ê Ê  Option-Spacebar
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203 À Ë Ë  Option-` Shift-a

204 Ã Ì Ì  Option-n Shift-a

205 Õ Í Í  Option-n Shift-o

206 Œ Î Î  Option-Shift-q

207 œ Ï Ï  Option-q

208 – Ð Ð  Opt-hyphen

209 — Ñ Ñ  Option-Shift-hyphen

210 “ Ò Ò  Option-[

211 ” Ó Ó  Option-Shift-[

212 ‘ Ô Ô  Option-]

213 ’ Õ Õ  Option-Shift-]

214 ÷ Ö Ö  Option-/

215 ♦ × ×  Option-Shift-v

216 ÿ Ø Ø  Option-u y

217 Ÿ Ù Ù  Option-u Shift-y

218 � Ú Ú  Option-Shift-1

219 € Û Û  Option-Shift-2

220 ‹ Ü Ü  Option-Shift-3

221 › Ý Ý  Option-Shift-4

222 Þ Þ Þ  Option-Shift-5

223 þ ß ß  Option-Shift-6

224 ‡ à à  Option-Shift-7

225 · á á  Option-Shift-9

226 ‚ â â  Option-Shift-0

227 „ ã ã  Option-Shift-w
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228 ‰ ä ä  Option-Shift-r

229 Â å å  Option-Shift-m or Option-i Shift-a

230 Ê æ æ  Option-i Shift-e

231 Á ç ç  Option-Shift-y or Option-e Shift-a

232 Ë è è  Option-u Shift-e

233 È É é  Option-` Shift-e

234 Í ê ê  Option-Shift-s or Option-e Shift-i

235 Î ë ë  Option-Shift-d or Option-i Shift-i

236 Ï Ì ì  Option-Shift-f or Option-u Shift-i

237 Ì í í  Option-` Shift-i

238 Ó î î  Option-Shift-h or Option-e Shift-o

239 Ô ï ï  Option-Shift-j or Option-i Shift-o

240 (Apple) Ð ð  Option-Shift-k

241 Ò ñ ñ  Option-Shift-l or Option-` Shift-o

242 Ú ò ò  Option-Shift-; or Option-e Shift-u

243 Û ó ó  Option-i Shift-u

244 Ù Ô ô  Option-` Shift-u

245 ý õ õ  Option-Shift-b

246 ˆ ö ö  Option-Shift-i

247 ˜ ÷ ÷  Option-Shift-n

248 ¯ ø ø  Option-Shift-,

249 ¢ ù ù  Option-Shift-.

250 ÿ ú ú  Option-h

251 � Û û  Option-k

252 ¸ Ü ü  Option-Shift-z
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253 ½ Ý ý  Option-Shift-g

254 ² Þ þ  Option-Shift-x

255 ¡  Option-Shift-t
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Support

For sales information or technical support for VedaPad, please contact the publisher,
Kevin Carmody, at support@kevincarmody.com .

Online descriptions of VedaPad and VedaType:
http://kevincarmody.com/software/vedapad.html .

To purchase VedaType (for Macintosh):
https://secure.bmtmicro.com/servlets/Orders.ShoppingCart?CID=5115&PRODUCTID=5
1150001 .

To purchase VedaPad (for Windows):
https://secure.bmtmicro.com/servlets/Orders.ShoppingCart?CID=5115&PRODUCTID=5
1150000 .

To download Adobe Acrobat Reader:
http://www.adobe.com/products/acrobat/readstep2.html .

To download PrintToPDF: http://www.jwwalker.com/pages/pdf.html .

To download Font Checker:
http://mac.softpedia.com/get/Font-Tools/Font-Checker.shtml .

To download Font Sampler:
http://mac.softpedia.com/get/Utilities/Font-Sampler.shtml .

Credits

Fonts developed by Peter Freund.
Manual written by Kevin Carmody.
Copyright © 2005–2006 Kevin Carmody.


